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Course objectives 
1. To provide the class with an exploration 
of desktop publishing. 
2. To assist class development of various 
documents using Microsoft Publisher 2002. 
3. To develop computer literacy. To address 
the class' questions. 

Schedule 
 9:00 Registration 
 9:30 Morning session 
 10:40 approximate break 
 12:00 Lunch 
 1:00 Afternoon session 
 2:00 approximate break 
 3:30 Dismissal 
 
Handouts available in PDF format at 
www.crowleycomputers.com/handout.htm.

General session topics 
Microsoft Office Publisher 2007 helps 
users create, personalize, and share a 
wide range of publications. New and 
improved capabilities in Publisher 2007 
guide users through the process of 
creating and distributing publications. 
 
The class will cover: 
1. Desktop publishing 

A. Spectrum of users and uses 
B. Tools of the trade 

2. Structural overview 
3. Objects are everything! 
4. Getting started from scratch or 
templates 
5. DTP Rules of Thumb 
6. Better navigation 
7. Text 

A. Frames 
B. Making the most with and 

without color 
C. Be lazy, use tools 
D. Semi-universal object 

formatting 
8. Clipart and pictures 
9. Don’t overlook master pages 
10. Tables gone wild 
11. Objectify objects 

A. WordArt 
B. Autoshapes 

12. Printing and reproduction 
techniques 
13. Web pages? 
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Session I 

1. What’s Publisher? 
Microsoft Publisher is an easy to use and powerful desktop publishing application. If you put together 
newsletters, banners, signs, calendars and many other things, Publisher may be the tool you need to learn more 
about. 
A. In a general sense we’ll explore: 

1. Design consistency 
2. Font usage 
3. Balance 
4. Printing and reproduction tips and tricks 

B. All of this will be within the specifics of Microsoft Publisher including: 
1. Design Gallery and Wizards 
2. Formatting 
3. Frames 
4. Hyphenation 
5. Graphics and scanning 
6. Kerning and other tips to “make it fit” 
7. Bringing information in from other applications 

2. Quiz 
A. Microsoft Word users? 
B. Microsoft Publisher users? 
C. Version? 
D. Experience 
E. Other desktop publishing applications? 
F. What do you want to learn today? 

3. Desktop publishing is… 
A. Using a personal computer or workstation to produce high quality printed documents using various 

typefaces, margins and justifications with embedded graphics and illustrations.  
B. Getting difficult to distinguish desktop publishing from word processing.  
C. DTP 

4. Who does desktop publishing? 
A. A graphic designer or other professional (often with some formal training or background) who uses desktop 

publishing software (most often the high-end programs such as Adobe PageMaker or QuarkXpress) to design 
documents for clients.  

B. A small or home-based business person (often self-trained or with a background other than design or 
printing) who uses their computer and desktop publishing software to design documents for clients.  

C. A small or home-based business person with a word processing, resume, or office support business who 
uses their word processing software (usually) to design documents for their word processing clients.  
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D. A person who uses their computer and desktop publishing software to design documents for their own 
business (not for clients). Will usually use low-end to midrange desktop publishing software and print 
documents directly to their desktop printers.  

E. A secretary, administrative assistant, or other office support person who uses word processing or desktop 
publishing software to design documents for an employer -- in addition to their normal, non-design duties. 

5. Tools of the trade 
A. Word processor - will save time depending on proficiency; it will increase quality. Time savings are huge in 

retyping but this is often canceled out by the time you spend making tiny revisions striving for perfection. 
B. Page layout program - again, time saving is highly dependent on proficiency, but increases in quality and 

capability can be huge. The more options the program has, the more time it takes to learn but the more 
options you have for fine tuning your layout and type. Any modern application is WYSIWYG. 

C. Graphics editor - leads to pictures tuned for your needs, trim with fat and altered for better attention 
grabbers! Again, this may save time, but will increase quality and capabilities. 

6. The competition 
A. Print Shop Deluxe v23 and Print Explosion Deluxe v3 (Mac) 

1. Basic capabilities 
2. Easy to use 

B. Scribus v1.3  
1. Open source application available on multiple platforms 

C. Adobe InDesign CS3 and Quark QuarkXPress 8 (Mac) 
1. Advanced capabilities 
2. Multiuser 

7. Versions 
A. 2007 
B. 2003 
C. 2002, aka Xp 
D. 2000 
E. 98 

8. Document compatibility - Publisher 2007 does not have a new file format! 
A. Publisher has always been able to save to previous versions, but I don’t recall Microsoft ever updating older 

versions to read the newer files.  
B. All use .pub extension. 

 Application version Document version 
 2007 

Current format  2003 
 2002 
 2000 2000 only 
 98 98 only 
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9. What’s New for 2007? 
A. Better, more professional templates 
B. Create reusable content 
C. Improved Pack and Go for working with printing houses 
D. Banner printing if printer handles banner sized paper 
E. Improved mail merge from Word 
F. Save as PDF (with download) or XPS 
G. Uses Office improved spell checker 
H. Jim’s Publisher 2007 notes  
I. Little changed in interface, would really benefit from the new GUI – how disappointing 
J. Templates and color schemes are not as well integrated as other Office applications 
K. Seems more stable with large documents 
L. Boring! 

10. Pieces Parts 

 
A. Title bar with minimize, restore, maximize, close 
B. Screen tips - hold mouse cursor still over any button 
C. Object box 

1. Handle 
2. Rotate handle 

Title bar 

Object box 

Scroll bars Scroll bars 

Page guides 

Status bar 

Tool bars Tool bars 

Task pane 

Menu 

Tool bars 

Allie Birthday.pub 
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D. Scroll bars - horizontal and vertical 
E. Page guides - for alignment assistance, do not print 
F. Status line - current location of cursor or location and size of object 
G. Toolbars - quick access to most used commands. Standard, formatting and object toolbars are normally 

displayed. 
H. Task pane - detailed assistance on many tools. 
I. Menu - all program choices 
 

11. Objects (or Elements) 
A. All items in your publication are objects 
B. Sometimes objects are referred to as elements 
C. Text, tables, shapes, graphics... 

1. Objects can be formatted, resized, deleted... 
as a complete unit. 

2. Select by mouse 
D. Basic object manipulation 

1. Object edge – grey dotted line  
a. Drag – move object  
b. Ctrl+drag – copies object 
c. Shift+drag – moves object horizontally or vertically 

2. Handles 
a. White circles – adjust object size 

i. Corner 
A) Drag – changes size proportionally, growing from corner 
B) Ctrl+drag – changes size proportionally, growing from center  

ii. Side 
A) Drag – changes size disproportionately, growing from side 
B) Ctrl+drag - changes size disproportionately, growing from center 

b. Green circle – rotate object 
i. Drag – rotates from center 
ii. Ctrl+drag – rotates from opposite (bottom center) white handle 
iii. Shift+drag – rotates from center, snapping each 15° 
iv. Ctrl+Shift+drag – rotates from opposite (bottom center) white handle, snapping each 15° 

c. Yellow diamond – changes slope or end point of object 
3. Delete – removes object. Can be undone. 

12. Creating new publications 

A. New button gives blank letter size sheet.  
B. File, New (or Ctrl+N) gives many options! 

Size handle 

Rotate 
handle

Object outline (position)

Size handle Size handle 
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1. Getting Started window shows same options 
as Publication Types  in lower left Task pane. 

2. Recent Publications on right hand side is the 
same as the lower section of the File menu. 

 

 

 

3. Publication 
Types 
a. Selecting any 

type gives 
appropriate 
templates on 
right.  

 

4. Blank Page Sizes 
a. Normal 

paper sizes 
b. Papers sizes 

from other 
categories 
are available. 
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5. View templates 
from Microsoft 
Office Online 
gives options and 
user ratings from 
Internet if a 
connection is 
available. 

6. Preview and 
options on the 
right. 

 

13. Creating and selecting objects  
A. Objects toolbar 

B. Select arrow 
1. Click on any object to select 
2. Ctrl+click to select or deselect multiple objects 
3. Drag to surround any object(s) to select 

C. Create objects 
1. Select the appropriate tool from the Object toolbar or Insert menu 
2. Drag to place the object 
3. If necessary complete steps, IE. Select the picture to put in the picture box.  

D. Delete objects 
1. Select 
2. Use the Delete key or Edit, Delete Object 

14. Text box 
A. Create a text box and enter text 
B. Format toolbar 
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C. Getting around better 
1. Special characters 
2. Zoom 
3. Zoom in and Out 
4. F9 is your friend! 

D. More formatting 
1. Select text or the entire object or multiple objects 
2. From Format menu 
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E. Connect Text Boxes 
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1. Completely automated 
a. Create a new text box 
b. Draw a text box 
c. Insert, Text File… 
d. Select Aristotle from 

Project G.docx and 
wait for conversion 

e. Yes use autoflow 
f. Yes, automatically 

create text boxes, 
watch Publisher 
created needed pages 
with text boxes. 

 

2. Semi automated 
a. Create a new text box 
b. Draw a text box 
c. Insert, Text File… 
d. Select Aristotle from 

Project G.docx and 
wait for conversion 

e. Yes use autoflow 
f. No, do automatically 

create text boxes. 
g. Create a new text box. 
h. Select the first text box.
i. Link button. 
j. Pour text into next box. 
k. Try adding and 

removing text from 
first box, watch 
autoflow work. 

 

3. Continuing on from 
previous example… 
a. Add a new page 
b. Put a text box on the 

new page. 
c. Autoflow text into the 

new text box. 

F. More text box formatting is in Format Pictures 

15. Pages  
A. Creating pages 

1. Right click on pages in status bar 
2. Insert menu 

B. Deleting pages 
C. View Two Page Spread 

16. Accessing commands 
A. Menus - click or Alt + Capitalized letter 
B. Shortcut menu - right click or Shift+F10 

17. Insert Picture 

In
se

rt
 p

ic
tu

re
 

In
se

rt
 fr

om
 s

ca
nn

er
 o

r 
ca

m
er

a 

Co
lo

rs
 

In
cr

ea
se

 c
on

tr
as

t 

D
ec

re
as

e 
co

nt
ra

st
 

In
cr

ea
se

 b
ri

gh
tn

es
s 

D
ec

re
as

e 
br

ig
ht

ne
ss

 

Cr
op

 

Li
ne

 /
 b

or
de

r s
ty

le
 

Co
m

pr
es

s 
pi

ct
ur

es
 

Te
xt

 w
ra

p 

Fo
rm

at
 p

ic
tu

re
 

Tr
an

sp
ar

en
t c

ol
or

 

Re
se

t p
ic

tu
re

 

              

 



C3 – Crowley Computer Consulting  Page 12 
\\MITHRANDER\Users\jim\My Documents\1Training\Office 2007\Publisher outline.docx Printed 10/15/2008 

A. Color  

 

B. Line style 

 

C. Compress pictures 

D. Edit wrap points 

 

 

E. Formatting through Format Picture 
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18. Other objects 
A. Tables 

1. After creation, all text formatting works. Borders and backgrounds work on the table rather than on 
words or paragraphs. 

2. Adjusting object size adjusts column and row widths accordingly. 
3. Columns and rows can be dragged to new widths. 



C3 – Crowley Computer Consulting  Page 14 
\\MITHRANDER\Users\jim\My Documents\1Training\Office 2007\Publisher outline.docx Printed 10/15/2008 

 

4. Table menu a. Insert b. Select 

 

c. Diagonals 

5. Don’t just think text for tables! 
a. Helpful for aligning pictures and other objects!  
b. May cause problems with wrapping around pictures. One technique that can be used is to apply the 

table, use it to align pictures and text boxes (don’t use the table for text boxes). Then select and 
delete the table. 

c. Insert a table from Excel 
B. WordArt 

1. Gallery 2. Editing text 

 

3. Shape 4. Spacing 
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5. See Format Picture options for all formatting. 

  

6. WordArt Toolbar  
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C. AutoShapes 
1. Lines, arrows, ovals and rectangles are AutoShapes. AutoShapes all 

work the same! Autoshapes are called Shapes in other Office 2007 
applications. 

2. More AutoShapes is clipart! 
3. Usage 

a. Select your Autoshape from the Object toolbar or Insert menu. 
b. Drag the crosshairs from one corner to the opposite corner and release the mouse. 
c. After creation, all text formatting works. Borders and backgrounds work on the AutoShape rather 

than on words or paragraphs. 
d. See Format Picture options for all formatting. 
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D. Clipart - After 
inserting, it’s just a 
picture!  

 

E. Content Library – 
allows you to create 
your own list of 
repeatedly used 
pictures, clipart, etc. 
1. Add items to 

library  
a. Insert the 

object as 
normal. 

b. Use Add to 
Content 
Library 
from 
Standard 
Toolbar, 
right+click 
or Insert 
menu. 

c. Categorize! 
2. Use Library by 

clicking button 
on Object 
toolbar or Insert 
menu. 

 
F. Design Gallery – clipart for 

designs? 
 



C3 – Crowley Computer Consulting  Page 17 
\\MITHRANDER\Users\jim\My Documents\1Training\Office 2007\Publisher outline.docx Printed 10/15/2008 

19. Standard toolbar 
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20. Format Publication Task Pane 
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21. Type hype 
A. Type Style - A collection of type families related by 

common characteristics. There are essentially 
seven type styles: Roman, Italic, Sans Serif, Slab 
Serif, Text, Script and Decorative. 

B. Type Face - A unique design of a set of characters, 
based on some overall design or desired 
appearance.  

 

C. Type Family - A collection of typefaces related in 
design but differing in character weights and 
styles.  

D. Point - is only the expression used for the distance 
between ascender (portion of a lower case letter 
that rises above the letters x-height) and 
descender (portion of a character that extends 
below the base line of the character) and as such 
cannot describe the proportional relationship of 
any type face's x-height to its ascenders and 
descenders. If one chooses two different faces, 
such as Helvetica and Garamond, they will appear 
on the page very differently. 1 point ≈ 1/12 pica ≈ 
1/72" 

 

E. Kern - the process of subtracting space between 
two characters so that they appear closer 
together. This is usually done to improve the 
aesthetic appearance of most words that are set in 
all capitals especially in large display and headline 
text lines. 

 
F. Set Width - width of characters as defined by the creator. Proportional to size, but adjustable. 
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22. Creating contrast with types 
A. Capitalization 
B. SMALL CAPS 
C. Reverse 
D. Italicize 
E. Weight ie. Bold 
F. Combinations 

G. Size 
H. Position: rotation, alignment 

I. Color 
J. Alternate typeface  

23. Using Styles 
A. Use for creating the same look on text in multiple locations! Also used for generating Tables of Contents and 

other lists.  
B. Use from Format Toolbar, Format menu or Styles Task pane  
C. Usage 

1. Modifying 
2. Creating new styles 
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24. Format Publication 
A. Font schemes B. Color schemes C. Page options D. Publication options 

25. DTP Rules of Thumb 
A. Alignment - Everything on the page should align with something else. A grid is an effective tool in insuring 

that text and images align. Break alignment only for emphasis and sparingly within a piece. 
B. Margins  - Avoid using the same margins on all sides of a publication. In publications with facing pages, the 

outside margin of each page should be double the inside margin. For best appearance, margins should be 
sized progressively from smallest to largest: inside, top, outside, bottom. 

C. White space - many novices miss using “nothing” to break up text and graphics to provide breathing room. 
D. Rule of Thirds - Visually divide your page into thirds. Place elements on the page within these thirds for a 

more interesting and visually appealing layout. 
E. Size - One measure of importance is size. Use larger graphics to communicate the most important goals of 

the piece. Smaller graphics are of lesser importance. When space is at a premium, drop the smaller 
elements first — they are less important. 

F. Proofreading - Two rounds of proofreading catch 98 percent of the errors in a publication. 

26. Hyphenation 
A. Publisher normally hyphenates. 
B. Alter from Tools, Language, Hyphenation or via right+click 

Create a newsletter.
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27. Fill, Line and Text options 
A. No Fill does not equal white fill! 
B. Sample Fill Color 
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28. Background
s – prearranged 
fills that use 
complimentary 
color schemes or 
pictures. 

29. Other 
formatting 
A. Line / border style 
B. Dash style 
C. Arrow style 
D. Shadow 
E. 3D 

 
 



C3 – Crowley Computer Consulting  Page 23 
\\MITHRANDER\Users\jim\My Documents\1Training\Office 2007\Publisher outline.docx Printed 10/15/2008 

30. Automatic copy fitting – Autofit 

31. Arranging objects – from toolbars or Arrange menu 
A. Order 

 

B. Rotate and flip 
1. You can also use the green 

handle! 

 
 

 

C. Group 

 
D. Snap 

 

E. Nudge – you can also use arrow 
keys when an object is selected 

 

F. Align  
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32. Proofing and 
automation tools 
A. Spell checker 
B. Thesaurus 
C. Date / time 
D. Autocorrect 
E. Customize  
F. Help 

 

33. Emphasizing 
A. Balance / imbalance 

1. Perceived 
2. Mathematical 

B. Symmetry / asymmetry 

34. Other attention 
grabbers  
A. Pull quotes - pulled from an 

article to grab the reader’s 
attention and bring them in. 
From Design Gallery. 

B. Drop cap - initial letter is larger 
than rest of paragraph text. 
Looks kind of goofy in this 
example, don’t use it in an 
outline. From Insert menu. 

35. Using data from other applications 
A. Via Cut / Copy /Paste 
B. Edit in Microsoft Word 
C. Insert, Object 

36. Printing and reproduction 
A. Quick Print 
B. Print Preview 
C. Print Setup and Print 
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37. Pack and Go 
A. Gathers all files making up the document. 
B. Two options from File menu, Pack and Go are the same, just different selections in step 3. 

1. Take to another computer 
2. Take to a commercial printer 

38. Web pages  
A. Ah, er, no. Wrong tool. You’re loosening the bolt with pliers. Get a wrench. 
B. Web design tools 

1. Microsoft FrontPage, now replaced by Expression 
2. Adobe DreamWeaver 

3. Freeware: Nvu, Stepzilla…  
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39. Menus 
A. File 

 

B. Edit C. View 

D. Insert 

 

E. Format F. Tools 
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G. Table 

 

H. Arrange I. Window 

 
J.  Help 

 


